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Please read this Agreement before installing the software.

Software license agreement

Roland DG Corporation (hereinafter referred to as the “Company”) shall grant you a non-transferable, non-exclusive right to use
the Software supplied with this Agreement, on the condition that you agree to the following provisions.
Install the software if you agree with the following provisions.  The Agreement is deemed to have been concluded once the
software has been installed.  If you do not agree with the following provisions, do not install the software.

1. Definition
The “Software" includes the software program and related files supplied with this Agreement and the related software programs
and files distributed through the Internet and other services.

2. Ownership
All the ownership, copyright and other intellectual property rights of the Software, trademark, and related documents shall
belong to the Company.

3. Terms and conditions
(1) You are authorized to use the Software on one computer.
(2) You are allowed to create a backup copy of the Software.
The right to keep the Software and the backup copy of the Software continues to belong to the Company, but the right to the
media on which the backup copy of the Software is recorded does not belong to the Company.

4. Forbidden items
(1)  This copy of the Software, or a backup copy of the Software, must not be used on multiple computers at the same time, on
a network, the Internet, or on other computers through any other means of distribution.
(2) The Software shall not be reverse engineered, decompiled or reverse assembled.
(3) The rights to the Software cannot be transferred, assigned, lent, loaned or licensed to a third party in any case, regardless of
whether this Agreement has been terminated or cancelled.

5. Termination
(1) The Company can cancel this Agreement and require you to discontinue use of the Software if you breach any provision of
this Agreement or if you infringe on the ownership, copyright, or other intellectual property rights of the Company.
(2) This Agreement shall be automatically terminated when you stop using the Software.
(3) If this Agreement is terminated or cancelled, you must return your copy of the Software to the Company, or discard it as soon
as practicable, at your own expense.

6. Guarantee
(1) The Company shall not guarantee that the quality or functionality of the Software will satisfy any purpose that you may have
in mind.
(2) The Company shall not accept any responsibility for the results obtained from using the Software.
(3) The Company shall not accept any responsibility for any loss which might be caused as a result of your exercising the rights
granted under this Agreement.
(4) The specifications for the Software are subject to change without prior notice.

7. Governing law
This Agreement shall be governed by the laws of Japan.
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Used for instructions intended to alert the user to the risk of death or
severe injury should the unit be used improperly.

About WARNING and CAUTION Notices

Used for instructions intended to alert the user to the risk of injury or
material damage should the unit be used improperly.

* Material damage refers to damage or other adverse effects caused with
respect to the home and all its furnishings, as well to domestic animals
or pets.

WARNING

CAUTION

About the Symbols

The  symbol alerts the user to important instructions or warnings.  The specific
meaning of the symbol is determined by the design contained within the triangle.  The
symbol at left means "danger of electrocution."

The  symbol alerts the user to items that must never be carried out (are forbidden).
The specific thing that must not be done is indicated by the design contained within the
circle.  The symbol at left means the unit must never be disassembled.

The  symbol alerts the user to things that must be carried out.  The specific thing that
must be done is indicated by the design contained within the circle.  The symbol at left
means the power-cord plug must be unplugged from the outlet.

 To Ensure Safe Use

Improper handling or operation of this machine may result in injury or damage to property.
Points which must be observed to prevent such injury or damage are described as follows.
*Please also read the important safety information in the user's manual for the modeling ma-
chine.
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 Incorrect operation may cause injury

WARNING

Be sure to follow the operation proce-
dures described in this manual.
Failure to follow the procedures may cause
sudden operation or the like of the machine,
which may result in unexpected injury.

Never allow anyone unfamiliar with
the usage or handling of the machine
to touch the machine.
Touching a dangerous location may cause
sudden operation or the like of the machine,
which may lead to an unexpected accident.

Never allow children near the ma-
chine.
The machine includes locations and
components that pose a danger to chil-
dren, and major accident, including in-
jury, blindness, or choking, may occur.

Never touch the tip of the probe. Also,
be sure to attach the probe cover when
the sensor unit is not in use.
The tip of the probe is very sharp, and can
cause injury or blindness.

Do not disassemble, repair, or modify.
Doing so may lead to fire or abnormal op-
eration resulting in injury.

 Important Notes on Scanning

CAUTION

Never attempt to scan any object of
high intrinsic or personal value, or that
would otherwise be difficult to replace
if damaged or broken.
Because scanning involves contact by the
probe, the object scanned may be damaged.
Incorrect settings may also cause the
scanned object to strike areas other than
the probe. Scan-object damage is not cov-
ered by warranty.

When loading an object to scan, make
sure that all sides and the top of the
object are within the scannable area.
A scanned object may strike a component
other than the probe and suffer damage.
Scan-object damage is not covered by war-
ranty.

Be sure to remove the probe cover
when performing scanning.
Otherwise the object scanned may strike
the probe cover and suffer damage. Scan-
object damage is not covered by warranty.
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 Pour utiliser en toute sécurité

La manipulation ou l'utilisation inadéquates de cet appareil peuvent causer des blessures ou
des dommages matériels. Les précautions à prendre pour prévenir les blessures ou les dommages
sont décrites ci-dessous.
*Lire sans faute les importants renseignements sur la sécurité dans le guide de l'utilisateur de
la machine à modeler.

Utilisé pour avertir l'utilisateur d'un risque de décès ou de blessure
grave en cas de mauvaise utilisation de l'appareil.

Avis sur les avertissements

Utilisé pour avertir l'utilisateur d'un risque de blessure ou de dommage
matériel en cas de mauvaise utilisation de l'appareil.

* Par dommage matériel, il est entendu dommage ou tout autre effet
indésirable sur la maison, tous les meubles et même les animaux
domestiques.

ATTENTION

PRUDENCE

À propos des symboles

Le symbole  attire l'attention de l'utilisateur sur les instructions importantes ou les
avertissements.  Le sens précis du symbole est déterminé par le dessin à l'intérieur du
triangle.  Le symbole à gauche signifie "danger d'électrocution".

Le symbole  avertit l'utilisateur de ce qu'il ne doit pas faire, ce qui est interdit.  La
chose spécifique à ne pas faire est indiquée par le dessin à l'intérieur du cercle.  Le
symbole à gauche signifie que l'appareil ne doit jamais être démonté.

Le symbole  prévient l'utilisateur sur ce qu'il doit faire.  La chose spécifique à faire est
indiquée par le dessin à l'intérieur du cercle.  Le symbole à gauche signifie que le fil
électrique doit être débranché de la prise.



Pour utiliser en toute sécurité

5

 L'utilisation incorrecte peut causer des blessures

ATTENTION

S'assurer de suivre les procédures
d'utilisation décrites dans ce manuel.
Si les procédures indiquées ne sont pas
suivies, le fonctionnement de l'appareil peut
être déclenché soudainement, ce qui risque
de causer des blessures.

Ne jamais permettre à quiconque de
toucher l'appareil s'il ou si elle n'en
connaçò pas le fonctionnement ou la
manutention.
Toucher l 'appareil à certains points
dangereux peut en déclencher le
fonctionnement, ce qui risque de causer un
accident imprévu.

Ne jamais laisser d'enfants s'approcher
de l'appareil.
Des éléments et des surfaces de l'appareil
présentent des risques pour les enfants. Il
pourrait se produire un accident grave qui
causerait des blessures, ou créerait un ris-
que de cécité ou de suffocation.

Ne jamais toucher l'extrémité de la
sonde. S'assurer de fixer le couvert de
la sonde lorsque le capteur n'est pas
utilisé.
L'extrémité de la sonde est très acérée et
peut causer des blessures ou la cécité.

Ne pas démonter, réparer ni modifier.
Démonter, réparer ou modifier l'appareil ris-
que de provoquer un incendie ou de causer
un fonctionnement anormal entraînant des
blessures.

 Remarque importante sur la numérisation (scanning)

PRUDENCE

Ne jamais tenter de numériser un
objet de grande valeur monétaire ou
sentimentale, ou un objet qui serait
difficile à remplacer s'il était
endommagé ou brisé.
Les objets numérisés risquent d'être
endommagés parce que la numérisation
exige un contact entre la sonde et l'objet.
En outre, si les réglages sont erronés, l'objet
numérisé peut frapper des points autres que
la sonde. La garantie ne couvre pas les objets
numérisés.

Pendant le chargement d'un objet à
numériser, s'assurer que tous les côtés
et la partie supérieure de l'objet sont
à l'intérieur de la surface numérisable.
Un objet numérisé peut frapper une
composante autre que la sonde et être
endommagé. La garantie ne couvre pas les
objets numérisés.

S'assurer de retirer le couvert de la
sonde pour faire la numérisation.
Sinon, l'objet numérisé peut frapper une
composante autre que la sonde et être
endommagé. La garantie ne couvre pas les
objets numérisés.
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Important Notes on Handling and Use

This unit is a precision device. To ensure the full performance of this unit, be sure to observe the
following important points. Failure to observe these may not only result in loss of performance,
but may also cause malfunction or breakdown.

This Unit Is a Precision Device

➢ Never drop or subject to impact.
➢ Never twist or wrench the probe by hand.
➢ When not using the sensor unit, attach the probe cover and store in a safe place.

Items That may Not Be Copied

Unauthorized reproduction of a copyrighted item for any purpose other than personal use may be a
violation of copyright.
Roland DG Corp. will not be responsible for any violation of third-party copyright by any article made
through use of this product.
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Chapter 1
Preparing the Sensor Unit
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1-1  3D Scanning Sensor Unit

Supported Models

➢ Roland DG   MDX-40series
➢ Techsoft   TS-30

Most of the figures in this document depict the MDX-40.

Unit Features

This is an optional unit that enables you to use any of the preceding compatible models of modeling
machines as a 3D scanner. Replacing the spindle unit with the sensor unit adds contacting 3D-scanner
functionality. Dedicated programs for 3D scanning and for editing 3D data are included.

Checking the Included Items

Sensor unit Cap screws (black) Hexagonal wrench (3 mm)*

Roland Software Package
CD-ROM User's Manual (this manual)

* A 2.5-mm hexagonal wrench is included with the modeling machine.

Clay
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Part Names and Functions

Probe
This touches the scan object
and senses its shape.

Connector
This is the connector for con-
nection to the modeling ma-
chine.

Probe cover
This cover protects the probe.
When not using the sensor unit,
be sure to attach the probe
cover.
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1-2  Installing the Sensor Unit

Installing the Sensor Unit

CAUTION Before you carry out this operation, switch off the power to the model-
ing machine.
Failing to do so may result in sudden movement of the machine, causing the hands
or fingers to become caught and resulting in injury.

CAUTION Do not touch the spindle motor immediately or cutter after a cutting
operation has ended.
Doing so may result in burns.

CAUTION Perform installation and removal of the sensor unit while the cover is
attached.
Otherwise the probe may stab the hand or fingers and cause injury.

Before you install the sensor unit, complete the setup operations for the modeling machine. For information
on how to perform setup, refer to the documentation included with the modeling machine.

Procedure

➊ ➀ Switch off the power to the modeling ma-
chine and unplug its power cord. If a tool is
installed, then remove it.

➁ Remove the belt.

➋ ➀ Remove the cap screw shown in the figure.
➁ Remove the spindle unit.

➌ Install the sensor unit, using black cap screws.

Hexagonal wrench
(3 mm)

Hexagonal wrench
(3 mm)
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➍ ➀ Slightly loosen the cap screw shown in
the figure.

➁ Turn the connector cover to open it.
➂ Retighten the cap screw.

➎ Insert the cable for the sensor unit into the
connector.

➏ Detach the probe cover.

CAUTION
Be sure to remove the probe cover when
performing scanning.
Otherwise the object scanned may strike the
probe cover and suffer damage. Scan-object dam-
age is not covered by warranty.

Carefully store the removed spindle unit, belt, cap screw, and probe cover so that they do not become
misplaced.

To Reinstall the Spindle Unit

➢ Switch off the power to the modeling machine, then carry out installation by following the foregoing
procedure in reverse.

➢ The belt has an inner side and an outer side. Be sure the two sides are oriented correctly.
➢ After attaching the belt, turn the pulley by hand several times to acclimatize the belt.

The white mark indicates the outer side.

Hexagonal
wrench (2.5 mm)
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1-3  Preparing the Programs

System Requirements for the Programs

Operating system: Windows XP/Vista
CPU: Pentium 4 processor or better recommended
Memory: 512 MB or more recommended
Free hard-disk space required Dr. PICZA3: 20 MB or more, 3D Editor: 10 MB or more
for installation:
Display: 800 x 600 resolution and 16 bit colors (High Color) or more

recommended.
OpenGL-compatible accelerator board recommended.

➢ The Windows-based driver for the modeling machine must already be installed and the computer and
modeling machine must be connected by a USB cable.

➢ Memory requirement are affected by scanning conditions and the like. Larger scanning areas and finer
scanning pitches require increasingly more memory. We recommend installing enough memory to match
your usage conditions.

Step 1: Installing and Setting Up the Programs

Programs to Install and Set Up
➢ Dr. PICZA3: This program enables you to perform 3D scanning.
➢ 3D Editor: This program enables you to edit scanned 3D data.

Procedure

➊ Install the Windows-based driver for the mod-
eling machine and make the connection using a
USB cable.
For more information, refer to the documentation
included with the modeling machine. If the con-
nection is already made, go on to procedure 2
below.

➋ ➀ Log on to Windows as "Administrators."

➁ Insert the Roland Software Package CD-ROM
into the computer.

(Windows Vista only: When the automatic play-
back window appears, click [Run menu.exe].)

The setup menu appears automatically.

Windows driver

Roland Software Package
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➌ Click the program you want to install and setup.

➍ Windows XP
The setup program starts. Follow the messages to
carry out setup and finish setting up the program.

Windows Vista
The [User Account Control] appears, click [Al-
low]. The setup program starts. Follow the mes-
sages to carry out setup and finish setting up the
program.

➎ When installation finishes, the screen shown at
left appears. Click [Close] or [OK].

➏  Repeat steps 3, 4, and 5 to install and set up each program.
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Step 2: Making the Settings for Dr. PICZA3
Procedure

➊ Turn on the power to the modeling machine.

➋ ➀ From the [Start] menu, click [All Programs] -
[Roland Dr. PICZA3] - [Dr. PICZA3].

➁ Go to the [File] menu and click [Preferences].

➌ ➀ For [Port], select the model name of the mod-
eling machine you're using.

➁ Click [OK].
➂ Go to the [File] menu and click [Exit] to quit

Dr. PICZA3.

This completes the preparations for the program.

Checking the Connection
In Dr. PICZA3, go to the [Help] menu and display [About]. If the firmware version and model name are
displayed, the connection is correct.
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Chapter 2
Use and Operation As a
3D Scanner
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2-1  Operation As a 3D Scanner

Operation As a 3D Scanner

Startup

➊ Close the front cover.

➋ Switch on the main power switch.
The POWER light comes on.

➌ Press the Sub power button.
The machine starts up, and initialization is per-
formed.

To Start Scanning
➢ Confirm that the SCANNING light comes on.
➢ Confirm that the VIEW lamp goes dark.
➢ During scanning, never open the front cover.
➢ You can pause scanning by pressing the VIEW button. Pressing the VIEW button a second time resumes

operation.
➢ You can open the front cover while operation is paused.

Operation During the Scanning Mode
➢ The SCANNING light comes on when the machine is in the scanning mode.
➢ The machine automatically changes to the scanning mode when the sensor unit is installed and to the

modeling mode when the spindle unit is installed.
➢ The operation of other buttons and controls is identical both in the scanning mode and in the modeling

mode. Refer to the documentation included with the modeling machine.
➢ When in the scanning mode, the "operation-panel screen(VPanel)" cannot be used.
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Objects That Can and Cannot Be Scanned

Objects Unsuitable for Scanning
Objects that change shape when touched by the probe cannot be scanned.

➢ For example, objects such as items made of soft rubber or fuzzy stuffed animals cannot be scanned.
➢ Depending on the configuration of the object, error equal to about the radius of the probe (0.5 mm) may

occur.

CAUTION Never attempt to scan any object of high intrinsic or personal value, or
that would otherwise be difficult to replace if damaged or broken.
Because scanning involves contact by the probe, the object scanned may be dam-
aged. Incorrect settings may also cause the scanned object to strike areas other
than the probe. Scan-object damage is not covered by warranty.

Scannable Area
The figure shows the scannable area.

The size that can actually be scanned depends on the amount of memory in the computer. For more
information, refer to page 20, "Amount of Computer Memory Required."

305 mm (12 in.)

92.4 mm (3-5/8 in)
32.4 mm (1-1/4 in.)

305 mm (12 in.)

60 mm (2-5/16 in.)

Table

This area cannot be
scanned.
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Mounting the Object to Scan

Mounting the Object to Scan
➢ Secure in place with the surface to scan facing up.
➢ Secure firmly to keep from moving during scanning.

CAUTION When loading an object to scan, make sure that all sides and the top of
the object are within the scannable area.
A scanned object may strike a component other than the probe and suffer dam-
age. Scan-object damage is not covered by warranty.

Various Methods for Securing in Place
➢ Double-sided adhesive tape can be useful for flat-

bottomed object.

➢ When the bottom is uneven, it may be possible
to secure the object by pressing it into a piece of
clay.

To Scan a Small or Thin Object
If the portion you want to scan isn't positioned inside the scanning area, place a block or the like under-
neath it to elevate it.
However, be sure to keep its height at 92.4 mm (3-5/8 in.) or less from the table surface.

92.4 mm
(3-5/8 in.)

60 mm
(2-5/16 in.)

Maximum scanning area
This portion can
be scanned.

Block
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2-2  Using the Included Programs

User's Manuals for the Programs

Description of Basic Operation
 ☞ See page 21, "Chapter 3  Basic Scanning Operation"

Detailed Description
You can find detailed explanations of the programs in the online help (electronic-format manuals).

Dr.PICZA3
From the [Start] menu, click [All Programs] - [Ro-
land Dr. PICZA3] - [Dr. PICZA3 Help].

3D Editor
From the [Start] menu, click [All Programs] - [Ro-
land 3D Editor] - [3D Editor Help].

The Machine's Scanning Mode
This machine has only a single scanning mode. It does not support such scanning methods as rotary, plane,
line, or point scanning.
Data exported using the "Polylines" command is not supported.
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Amount of Computer Memory Required

Important Note about Required Memory
The amount of memory required increases proportionally as the dimensions of the scanning area grow
larger or as the scanning pitch is made finer. Insufficient memory can slow down the operation of the
computer, and even make it appear to freeze.

Estimating the Memory Requirements
Use the following information as a guide to estimate the amount of memory that Dr. PICZA3 requires.
(These figures do not include memory required by the operating system itself.)

Scanning area (width x depth) Scanning pitch Required memory
100 x 100 mm 0.05 x 0.05 mm Approx. 2 GB
100 x 100 mm 0.1 x 0.1 mm Approx. 500 MB
100 x 100 mm 0.5 x 0.5 mm Approx. 20 MB
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Chapter 3
Basic Scanning Opera-
tion
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3-1  Learning the Basics of Scanning

Step 1: Setting the Scanning Conditions

Let's start actually scanning something.
You mount the object to be scanned, start the 3D scanner, then use the 3D-scanning program to begin
scanning.

Procedure

➊ Start Dr. PICZA3 and display the [Settings for Scanning] dialog box.

➀ From the [Start] menu, click [All Pro-
grams] - [Roland Dr. PICZA3] - [Dr.
PICZA3].

➁ Click [Scan].

➋ Make the settings for the area to scan (width and depth).

Type in the lower-left and upper-right
locations of the scanning area.

It's a good idea to reduce the area to the smallest size necessary. Making the area larger than
necessary increases the scanning time and uses up excess memory.

➢ Clicking this returns to the original view.
➢ This enlarges (zooms) the displayed view. Click this, then drag to enclose

the area you want to enlarge.
➢ Click this to set or verify the scanning area.

➢ The orange quadrilateral indicates the area to scan (width and depth).
➢ Double-clicking a red square moves the probe to that location. You use this

to verify the scanning area.
➢ You can make the settings for the scanning area by dragging the red squares.
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➌ Make the settings for the area to scan (height direction).

➀ Enter the lower limit of the scanning
area (the distance of the location
from the table surface).

➁ Click this check box to select it.
➂ Find the highest location on the scan

object. Then drag this marker to that
location.

√ Click this button.

➢ The probe moves and touches the highest location of the scan object. (The area above this is not scanned.)
➢ If the location touched is not the highest, then redo ➂  and √ . If it is difficult to guide the probe to the

location you want, it may be useful to place a thick piece of paper or the like on top of the scan object,
then make the probe touch the surface of the paper.

➢ Omitting this setting causes the entire scannable area to be scanned from top to bottom.

It's a good idea to reduce the area to the smallest size necessary. Making the area larger than necessary
increases the scanning time and uses up excess memory.

➍ Set the scanning pitch, then start scanning.

➀ Enter the scanning pitch.
➁ Click [Scan].

Be careful not to make the scanning pitch too small. Smaller settings for the scanning pitch permit
scanning with correspondingly greater detail, but also use up correspondingly larger amounts of memory.
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Step 2: Checking the Scanning Results

You can preview the results while dragging the object to change its orientation and positioning.

Step 3: Saving and Exporting Data

If the results are acceptable, then save the data. You can also save (export) data converted to a format that
other programs can import.

Save
Go to the [File] menu and click [Save As].

➢ Data saved using this method can be opened in Dr. PICZA3 and 3D Editor.
➢ Once you have saved this data, you can export it in a variety of different formats.

Export
Go to the [File] menu and click [Export].

➢ 3D Editor also has an export feature. It lets you export data in a wider variety of formats than Dr.
PICZA3.

➢ These change how the object moves when
dragged (rotation, sliding, or zoom).

➢ These change the view.

➢ The three-dimensional item that has been
scanned is called the "object."
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Chapter 4
Appendix
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4-1  What to Do If...

The machine doesn't start

The VIEW light is flashing.
The sub power button was pressed while the front
cover was open, or the front cover was opened just
after the sub power button was pressed.
[MDX-40A]
Close the front cover .

[MDX-40, TS-30]
Close the front cover and switch the power of f. Keep
the front cover closed until startup finishes.

The SCANNING light flashes every 0.5 sec-
ond.
The front cover was opened before startup finished.
Close the front cover and switch the power of f. Keep
the front cover closed until startup finishes.

The SCANNING light flashes every 0.1 sec-
ond.
Something touched the sensor during initial opera-
tion immediately after switching on the power, or a
hardware error occurred.
If there is an obstruction, then switch of f the power,
remove the obstruction, and switch the power back
on. If there was a hardware error , then switch the
power off and back on and repeat the same opera-
tion. If the same error display occurs, consult your
authorized Roland dealer or service center .

Scanning is impossible

The MODELING light is on.
The sensor unit is not connected. Switch of f the power
and check again to make sure the sensor unit is in-
stalled.

The computer displays the message "Cannot
communicate with present scanner."
Was the modeling machine restarted while Dr . PICZA3
remained running?
Restart Dr . PICZA3. Restarting the modeling machine
while Dr. PICZA3 remains running makes communi-
cation impossible.
The setting for the communication port in [Preferences]
for Dr. PICZA3 is incorrect. Refer to page 14, "Step 2:
Making the Settings for Dr . PICZA3," and check the
setting.
Alternatively, no Windows-based driver for the mod-
eling machine is installed. Refer to the documenta-
tion for the modeling machine and install the driver .
Installing and setting up only Dr . PICZA3 does not
enable operation.
Alternatively, try switching off the power and restart-

ing the computer. Also, try changing the USB cable.
Use a USB cable less than 3 meters long, and don't
use a USB hub.

The VIEW light is on.
Operation is paused. Press the VIEW button to release
the paused state.

The VIEW light is flashing.
The front cover is open. Close the front cover and redo
the operation.

The SCANNING and VIEW lights are flash-
ing.
[MDX-40A]
Operation cannot be continued.

[MDX-40, TS-30]
The front cover was opened while scanning was in
progress. Operation cannot be continued. Switch the
power off, and redo the operation. To open the front
cover while scanning is in progress, first press the VIEW
button to pause operation.

Other Symptoms

Scanning ended, but the computer then
stopped.
Go to Dr. PICZA3's [Settings for Scanning] dialog box
and increase the scanning pitch. Alternatively, con-
sider installing more memory . When scanning exceeds
the amount of free memory on the computer , the op-
eration of the computer may become very slow .
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4-2  Specifications

Scanning-mode Specifications

These are the main specifications of the MDX-40series or TS-30 when the ZSC-1 is installed.

Maximum scanning area

Distance from probe tip to table

Table load capacity

Sensor

Scanning method

MDX-40series/TS-30 (ZSC-1 installed)

305 (X) x 305 (Y) x 60 (Z) mm  (12 (X) x 12 (Y) x 2-5/16 (Z) in.)

Maximum 92.4 mm  (3-5/8 in)

Maximum 4 kg  (8.8 lb)

Type: Roland Active Piezo Sensor (RAPS)
Effective probe length: 60 mm (2-5/16 in.)
Tip bulb radius: 0.08 mm (0.00315 in.)

Contacting, mesh-point height-sensing
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